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Use this
space for notes

Introduction
Word 2 is a course created for CAL PACT participants to increase your knowledge
of the features of Microsoft Word. This course covers selected intermediate level
material and applies to to both the Windows and Macintosh computer platforms.
This document serves as a future reference for you as you continue to gain
experience on your own. Some topics may not be covered in as much detail during
the course as they are in this document.  Documentation for previous versions of
Word may be found on the CAL PACT website at http://calpact.berkeley.edu

Skills you need for this course
• How to use the mouse
• Familiarity with the Windows or Mac operating systems
• Knowledge of basic computing concepts
• Solid understanding of the material covered in the CAL PACT Word 1

course

Skills and concepts you will learn in this course
• Mail merge
• Sections, Columns, and Breaks
• Tables
• Borders & Shading
• Margins & Indents
• Drop Caps
• Find & Replace
• Templates

Conventions used in this document
Menus and menu commands are separated by a vertical bar ( | ). In the document
they will appear as Menu|Command. An example of this is: “Select File|New...”
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Mail Merge
Mail Merge is a powerful tool that can create personalized form letters, envelopes,
and mailing labels. It consists of three basic components: the Main Document, the
Data Source, and the Merged Data.
The Main Document is the form letter, the mailing labels, or envelopes. This is
similar to a template. The information stored in the Main Document is the basic
format of the document that will not change with each letter, label or envelope.
The Data Source contains the personalized information for each letter, mailing
label, or envelope that will change with each letter, label or envelope. Examples of
information contained in the data source file include first name, last name, address,
city, state, and ZIP code.
The third component is the Merged Data. At this final stage the main document
and the data source are merged into a single file or sent to the printer to create
each individual letter, label, or envelope.

What Is Covered in Mail Merge:

• Creating a Main Document for a Form Letter
• Specifying a Data Source
• Creating a New Data Source
• Inserting Merge Fields into a Main Document
• Merging a Data Source with a Main Document

The Big Picture
Creating any type of mail merge document involves merging a Main Document
with a Data Source. We will create a form letter in class. In addition to the Main
Document and Data Source discussed above, Word uses Merge Fields to act as
place holders to represent data (such as names and addresses) that you want to
insert into your Main Document from the Data Source. The individual Merge Fields
instruct Word where to place different types of data (name, address, etc.) from the
Data Source.

Creating a Main Document for a Form Letter
The first step in creating a form letter is to open or create a document to use as the
Main Document. This Main Document contains the text, punctuation, spaces,
graphics, and any other textual or formatting information that will remain the same
in each letter. To get started, follow these steps:

1. Open or create the document you will use as the Main Document, just as
you would any document (a letter in this case). This document can be an
existing letter, a template or any letter you need to circulate widely.
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2. Select Tools|Letters and Mailings… The Mail Merge Wizard will be
shown as well as the Mail Merge Toolbar option.

         

      3. Under Document type (step 1), click on the Letters… option and then click
on the Next: Starting Document... button on the bottom.

4. Click on the Use the current document button
to use the currently open document as the Main
Document.

Specifying the Data Source
To indicate which information to merge with the Main Document for the form letter,
specify the Data Source. The Data Source file serves as a database consisting of
the information that will be merged with the Main Document. The Data Source file is
organized into individual records. Each record consists of fields representing the
types of information that you will personalize. The fields can be names, addresses,
and any other type of information you specify. You can create either a new Data
Source or open an existing one. (Data Source files may be used multiple times.)

5. Click Next: Select recipients at the bottom of the Mail Merge Palette to
view the options for the Data Source. This will allow you to use an existing
list, select from Outlook sources, or  type a new list.
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Creating a New Data Source
When you create a data source using the Mail Merge Palette, Word creates a
new file and organizes the information in a table. The table contains a column for
each category of information. The table contains an Enter Address Information
section which shows each of the specified Field Names as headers for each
column. Each row contains the information for each Data Record contained in the
Data Source. When merged with the Main Document each Data Record will
produce your personalized form letters, labels or envelopes, in the same order as
the records appear in the Data Record. Just follow these steps:

6. (Continuing from previous) Select the Type new list button. Then click on
the Create... option below and a New Address List dialog window will
appear, shown here.

         

7.  To add or remove a field from the list, click the Customize... button. When
adding a new field, you may change the order of the fields by simply
highlighting a field and clicking the Move up... button or Move down...
button.

8.  When you are satisfied with the field names, click OK.  Continue typing in
the information for all of your contacts.  When you have completed your list,
click on Close.

9. You are now required to save the new Data Source. Type a file name, select
where you wish to save the data, then click Save.

Field names have spaces
in the name.

  FYI
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10. Word then has options to edit, validate, and search the Data Source in the
Mail Merge Recipients dialog box, shown below.  Clicking on the down
arrows next to the field names (such as “Last Name” or “Title”) will allow you
to choose certain entries.  This is called “filtering.”  Make sure that all of the
individuals you want to include in your mail merge project have a checkmark
next to their record, then click OK.
In the Mail Merge task pane on the right, click Next: Write your letter to
move to step 4.

Writing your letter and Inserting Data Source Fields
If the letter is not on the main screen already, you can
select another letter or create one at this point.
Step 4 of Mail Merge is integrating the fields from your
Data Source into the correct locations in your main
document (a letter in our example).  Place your cursor in
your document where you want the field to be, then click
on the appropriate option in the task pane on the right.
You can also click More items... to select specific fields to
incorporate from your data source.

Word will not put spaces
between Merge Fields
automatically. If you do not
manually insert spaces,
the merged results will lack
spaces where you may
want them.

  Caution
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Selecting the first option, Address
block... will bring up the Insert Address
Block window, shown to the right.  In this
window, you can quickly specify the
address elements you want incorporated
into your letter.
The result on letter will show as follows:

When you are finished specifying all of
the fields you want in your document,
click the Next: Preview your letter
button to move to step 5.

Preview Your Letter
In this step you will be able to view your completed
letter with the actual data shown from your data
source.  To move up or down the list of recipient’s
names, click the  or  buttons.

If there is a specific recipient to whom you don’t want
this letter to be addressed, simply click the

 or Edit recipient list... to change
the current list.

Complete the Merge
This is the final step! Click Print... if you are completely satisfied with your letter
and data list. If you would like to go back and edit letters or edit the data recipient
list, simply click Previous... on the bottom of the page, and you will be guided
backwards in your process.
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Intermediate Word Formatting Options
Columns, Sections, and Breaks
You can create documents in Word with several
sections or several columns. Word allows you
to apply columns and other formatting options to
different sections of a document, as well as the
document as a whole. There are three kinds of
breaks which help you control the format of the
entire document and of each section.
A Page break will automatically end the current
page and force any additional text to begin on a
new page.
A Column break is similar to a Page break
except that it ends the current column and
forces any additional text to begin in the next
column.
The Section break is different from other breaks. By inserting a Section break, the
document can be divided so that each section acts as a separate entity for
purposes of formatting. Think of each section as being a separate mini-file. Each
section can have its own individualized page setup.
To insert a break, place your cursor at the location where you wish the break to be,
then select Insert|Break... Choose the type of break you want to insert, then click
OK.

To modify your document to
display in multiple columns,
select Format|Columns...  The
Columns dialog box will appear,
shown to the right.
Make sure that you specify how
much of the document to which
you wish to apply the column
formatting. At the bottom of the
box, the Apply to: option will
allow you to choose between
Whole document, or From this
point forward. To only change
the number of columns in
existing text of your document,
first highlight the area before
selecting Format|Columns... In the Apply to: box, you will have
the additional option to choose Selected text. However, if you
previously inserted section breaks, you may place the cursor
anywhere within a section and choose the number of columns
to apply to that section.
You can also quickly choose to modify your columns from the
toolbar button shown to the right.

In Normal view, only
one column can be
seen at a time,
regardless of the
actual number of
columns. By using
Print Layout view, all
columns can be
seen at the same
time. When using the
more advanced
formatting features in
Word, Print Layout
view is highly
recommended (and
s o m e t i m e s
necessary). Switch
between Normal and
Print Layout by
c h o o s i n g
View|Normal or
View|Page Layout,
or by clicking the view
buttons at the bottom
left corner of your
Word window.

  Tip

Page breaks and
Section breaks can
be inserted
anywhere in the
document. Column
breaks are useful
only in sections of the
document which are
set up with more
than one column.

  Note
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Tables
With tables, you can arrange columns of numbers and text in a document without
having to use tabs or indents, all in an orderly grid-like pattern. Text can be
presented in side-by-side paragraphs, as in a résumé, or arranged beside graphics.
To insert a table in your document, place your cursor where you would like the table
to appear. Then click the Insert Table button ( ) on the Standard Toolbar and drag
the pointer to fill the desired number of cells you want in the table. Once you
determine the dimensions, click and your table will appear.

        

Navigating and Manipulating a Table

• Add text into a cell by clicking within it and typing.
• Pressing the Tab key will move the cursor to the adjacent cell to the right.

Shift + Tab will move the cursor to the adjacent cell to the left. Control + Tab
will move one tab stop over within a cell.

• Paragraph returns within a cell will increase the height of the entire row
containing the cell.

• Change the column width by moving the column dividers in the Ruler. Note
that these column dividers appear in the ruler only when you place the
cursor at some point within the table.

• To delete a row or column, highlight the area and select Table|Delete and
the appropriate submenu command (Table, Columns, Rows or Cells...).

• To hide table gridlines, choose Table|Hide Gridlines.
• Use the arrow keys to move space by space within a cell and throughout the

table.
• An easy way to highlight entire columns or rows is to select

Table|Select|Row or Table|Select|Column. An alternate method to
highlight entire columns is to position the mouse so that it appears as a
down arrow, and then click the mouse button to select the column. You can
also highlight the entire table by selecting Table|Select|Table.

Word draws a thin
border around tables by
default. To see only the
gridlines for your
reference, you should
select the table and use
the Border button to
select no border.

  Note

At the last cell in the
table, push the right
arrow key on the
keyboard until the
cursor is positioned
just outside the table
boundaries. Press
Enter to automatically
add a new row.

  Tip
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Borders and Shading
You can create borders around text, tables, and images
to draw special attention to certain areas of your
document. Using borders to customize the appearance
of a table is especially useful. Shading can also be added
to selected areas, in grayscale and color. To apply
borders or shading to an image, table, or text, choose
Format|Borders and Shading… The Borders and
Shading dialog window will appear.

Note the three
different
window tabs in
the dialog
window.

Use the section under the Borders tab of the dialog window to create a border
around a selected area of text or an image. This is also used to create borders
around tables and to modify the appearance of individual cells or groups of cells
within tables when a table (or an area thereof) is selected.

Use the section under the Page Border tab to apply borders to entire pages of your
document. Note the similarity between the Borders section and the Page Border
section. Be sure you are working in the section in which you indend to work.

Use the section under the Shading tab to add shading to selected areas.

The Page Border section of
the Borders and Shading
dialog window allows you
to apply border and
shading effects to the
whole document or to
specified sections.

  Note

Colors will be printed as
shades of gray on non-
color printers.

  Note
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Drop Caps
In Word, a paragraph can have a large initial letter
or word called a Drop Cap. You can apply drop
cap formatting to just the first letter of a paragraph,
the entire first word, or some of the letters in the
first word. To have the entire word or part of the
word dropped, select the letters to “drop”. If
nothing is selected or if more than one word is
selected, only the first letter will be dropped by
default. To format a drop cap, select Format|Drop
Cap…
The Drop Cap dialog window provides two
options for positioning the letter (or word), as well
as an option to have no drop cap (useful if you
want to remove drop cap formatting previously
applied). The Dropped option positions the drop
cap at the upper left of the paragraph with the text wrapping around it. The In
Margin option positions the drop cap to the left of the text with no text wrapping.
The bottom portion of the dialog window provides options for changing the font of
the dropped letter. Adjust how large the dropped letter will be by selecting the
number of Lines to Drop. You can also adjust the spacing inserted to the right of
the drop cap, between the drop cap and the normal text by changing the value in the
Distance from Text field.

Find & Replace
Word provides a Find and Replace command to quickly find single or repeated
occurrances of text in your document, and replace it with alternate text of your
choosing. To quickly find specific text or formatting, select Edit|Find.... To replace
multiple occurrances of text or formatting with alternate text or formatting, select
Edit|Replace.... Either of these commands will bring up the same Find and
Replace dialog window. The different tabs will give you access to the different
sections as with other subdivided dialog windows.

               

You can also use the Go To
section of the Find and
Replace dialog window to
quickly move to the next
format or object change.
Click the Go To tab, then
choose the field you want
to find and click Next.

  Tip

You must use Print Layout
view to see drop caps
properly. Word will ask to
switch to Print Layout view
if it is not already in that
view. To remove a drop cap,
simply click in the
paragraph that contains
the drop cap, choose
Format|Drop Cap… and
select None in the Position
of the dialog window.

  Note
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Templates
A template is like a blueprint for the text, graphics,
and formatting of a document. Templates can be
used over and over again as a guide for commonly
used documents to avoid having to recreate
documents from scratch. Word provides pre-
designed templates for many common types of
documents such as memos, reports, business
letters, and fax cover sheets. You can also create
your own templates tailored to fit your individual
needs.

Basing a Document on a Template
1. Choose File|New…. The New dialog window

will appear.
2. The New window is subdivided into different tabs based on the type of

document you want to create. Click the appropriate tab and choose the
Template on which to base your document. (The default is General).

3. Click on the OK button.Many templates have
previews available. If a
preview is exists, it will
appear on the right-
hand side of the New
dialog window when
you click on a particular
Template.

  Note

If you can’t find the
templates, it may be that
they were not installed
with Word. Talk to your
system administrator if
you have questions
about this.

  Note
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Creating Your Own Template
1. Choose File|New….
2. In the New Document dialog window on the right hand side of the screen,

under the New from template choose from the general templates,
templates on your own web sites, or templates from Microsoft.

3. Set up all the styles, formatting, or text desired in your new Template.
4. Choose File|Save to save your new Template.

Modifying an Existing Template
1. Choose File|Open….
2. In the Files of Type pull-down menu, select Document Templates.
3. In the File Name field, type or select the name of the Template to modify,

then click OK.  (Note: be sure the Look in: field is directing Word to the
Templates folder).

4. Edit and format the Template as desired.
5. Select File|Save to save your customized Template.

Explore and experiment with these features to learn how Word can make your work
easier, and even fun.

Continue to Enhance your Word Skills
There are also many other features of Word XP that we have not covered during
our Word series. Microsoft Word Help offers a comprehensive listing of topics that
can help you along your way to becoming a Word expert. We encourage you to
explore and experiment with these features to learn how Word can make your work
easier, and even fun.

If you do not click the
Template radio button,
your template will be
saved as a regular Word
document rather than as
a Word template.

  Caution
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  Note

If you want to remove a
single item from your
selection without canceling
your entire selection, then
simply click the item a
second time while you
continue to hold down the
CTRL key.

APPENDIX
Browsing a Document
 A quick way to move around Word documents when you’re focusing on one type of
information, such as tables, is to click the browse buttons on the vertical scroll bar
to jump from one table to the next.
To select a browse option, click Select Browse Object on the vertical scroll bar
(the small round button), point to any button on the Browse Object palette to see
its description, and then click a button to set it as the browse option.

                                       

When you select a button other than Browse by Page, the browse buttons on the
vertical scroll bar turns blue to indicate that you’ve set a special option. To find the
previous or next instance of the object you’ve selected, click the Previous or Next
browse buttons. If you forget which option you’ve selected, point to one of the
browse buttons to see a ScreenTip that describes the selected option.

Selecting items that aren’t next to each other

1. Select the first item you want, such as a table cell or paragraph.
2. Hold down CTRL.
3. Select any additional items you want.

Selecting items with the same formatting

Perhaps you want to locate all the words in your document that are formatted a
certain way, such as with italic formatting.
It’s easy to select all text with the same formatting in your Word document with the
Styles and Formatting task pane. This can be helpful for viewing the text,
changing its formatting, or deleting it.
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Leave your mark: Keep track of changes
Tracking changes allows multiple individuals to have input on one document.  When
an individual suggests a change, the original information is kept in tact and the
suggestion is added.  This way, you can both “see where you’ve been” and “see
where you want to go.”

1. Open the document you want to revise or review.
2. On the Tools menu, select Track Changes. When the Track Changes

feature is enabled, TRK appears on the status bar at the bottom of your
document. When you turn off change tracking, TRK is dimmed.

3. Make the changes you want by inserting, deleting or moving text or graphics.
The changes will appear highlighted and/or underlined, but you can modify
this.

To change the font color and formatting of tracked changes

1. On the Tools menu, click Options, and then click the Track Changes tab.
2. To change the color and formatting options of your tracked changes, in the

Track Changes options section, choose the color and formatting you
want.

There are other options you can play with in that dialog box – you have to test them
out to see what works best for you.
Leader characters such as dotted, dashed, or solid lines in Word documents can
draw the reader’s eye across space in a line. You can automatically insert leader
characters to fill the space used before a tab stop. You use tab stops to line up
columns of the text.

To display deleted text with strikethrough formatting

1. Start Word.  A new blank document opens.
2. If the Reviewing toolbar is not visible, on the View menu, point to Toolbars,

and then click Reviewing.
3. On the View menu, click Print Layout.  This sets up the document view so

that you can see any changes you make.
4. Type some text in the page.
5. On the Reviewing toolbar, click Track Changes.
6. Select a few words ot text, and press DELETE. The text appears in a

balloon in the right margin of the page.
7. On the Reviewing toolbar, click Show, click Options, and, on the Track

Changes tab, choose Never from the Use Balloons (Print and Web
Layout) list. This action gets rid of the balloons and displays the deleted text
with strikethrough formatting in the body of the document.

8. Click OK.
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